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The Extended Guide to Mapping 
Compiled and Edited by _Haldir_ 

 

 

Introduction: 
This guide to mapping is a compilation of many great mapping tutorials and resources that can be 

found on the Third Age website (www.the3rdage.net), and also includes my own tips and advice that 

I’ve developed through my own mapping. 

 

There is a full credits list at the end of this tutorial, but I must thank m@tt for his excellent “How to 

Create an EA Quality Map” tutorial, which has helped me immensely in my mapping. It’s largely due to 

maps like his that inspired me to try mapping in the first place. EA Games have also provided helpful 

tutorials on mapping, as well as creating such a great game (as much as some of you hate EA, you 

have to give them that).  

 

This tutorial has been put together to hopefully be a definitive reference for all you beginner (and more 

experienced) mappers. 

 

This is largely for BFME 1, although much of it still applies to BFME 2. There are several other 

tutorials for setting up BFME 2 maps (see Credits and Resources). This is also mainly for 

multiplayer/skirmish maps, although I did include some basic info on scripting. The focus here is on 

gameplay and visual aspects. 

 

What You Need: 

1. Battle for Middle-earth Worldbuilder – you cannot use WB 2 for BFME 1 maps, or visa versa. 

  

2. At least 1.5 GB RAM – WB is quite a complicated program, so (unless you have a super PC) don’t 

have any needless things going on in the background. Close things like MSN Messenger, Adobe 

Photoshop, or iTunes before you start. If you need Internet Explorer, or Windows Explorer open, open 

them before WB.  

 

3. Patience and Determination – if you don’t have these then leave now. You’ll never become a good 

mapper.  

 

4. A decent image editing program – not needed for the maps themselves, but for things like the mini-

map and loading image. Adobe Photoshop is what I’ll be using; Gimp is also good and is free for 

download on the T3A site. 

 

 

What You Should Already Know: 

1. Whilst this will cover the basics as much as possible, don’t expect to hear “you can find this option 

two thirds of the way down in the View menu”. Try and familiarise yourself with the program a bit 

beforehand. 
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There is a lot of stuff in this tutorial, and you might not need to read it all. If you find a process that 

works well for you, then stick with that. Mapping is a bit of an art, with no real right or wrong 

way of doing things. This tutorial is just a guide with tips and tricks that either I (_Haldir_) or other 

mappers (such as m@tt), have found work for us. 
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Preparation and Concepts: 
Before you rush into mapping, it’s important to know what your map will be like, and how it’s going to 

look. 

 

Inspiration: 

Some people map random, generic places or gladiator type maps; whereas others map proper Middle-

earth locations. For the latter, drawings, maps, photos and descriptions are all incredibly useful in 

deciding what your map will look like. I am making a map of Forlindon. 
 

Left is the film’s map. A link is provided in the Credits and Resources 
page. 
Below, a nice looking picture that fits my own mental image of the 
place. 
 

 

 
 
 
 
 
 
 
 
 
 
 
 

 
 

 

It’s a good idea to have a preconceived image of what the place you are mapping will look like. I always 

imagined Forlindon to be a cliffy, coastal region with quite grassy surroundings. Trees will probably be 

evergreen or conifer type ones. The picture I found fits this description, and the sunset lighting fits the 

calm, peaceful Elven region. This picture will later become my loading image for the map. 

 

It’s important to have ideas as you are searching, but it’s also important to be flexible in 

your interpretations of an area. 

 

Any descriptions you find of your area are also useful, especially geographical ones. It happens that info 

on Forlindon is quite limited, so my imagination will have to fill the gaps. I can tell from the map 

though, that there are forests, mountains, and a river in the region, so these are all natural features I 

may want to include. 

 

 

Concepts: 

Once you have your area, and an idea of the natural features, 

it’s important to draw a concept (on the PC, or by hand) so you 

know what you’re doing. Here is mine: 

 
Blue = Ocean. Brown = contour lines. Red = Warg Lairs. Black = 
Impassable cliff. Black Circles = Plots. Big circles are castles, small circles 
are economy plots.  
 

I may decide to add a small fordable river into the map, though 

I’m not sure yet. It’s important to remain flexible in your ideas, 

so that you can adapt to any issues that form as you are 

mapping. 

 

When laying out your concept, there are many things to 

consider: 
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1. Balance and Gameplay.  

A good map has interesting yet balanced gameplay. This Forlindon map should be quite good, as 

the location of players is different to other 5p maps (eg Belfalas). The semi-circular cliff around the 

centre prevents the centre player being surrounded by 4 enemies, whereas other players would only 

have to compete with 3 others. Each player has immediate access to 2 economy plots, and 2 creep 

lairs. 

 

2. Space. 

You need enough room for battlefields and for pathing (paths must be at least 2 hordes wide). Narrow 

paths cause lag, and makes the AI less effective. Choke points are okay, just don’t go nuts. 

 

3. Natural Features. 

Have a loose idea of things such as trees, paths, rivers, rock types, animals etc… These things are 

largely drawn from your inspirations (your images and descriptions). 

 

 

 
The arrows show the players and their surrounding enemies (in a free-for-all). Each player has 2 immediate threats.
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Getting Started: 
Close any unnecessary programs and open Worldbuilder. Press “Accept”, and then wait for it to load. It 

does take a little while, just be patient. 

 

 

Once WB is open, you can hold your mouse over the tools to see what 

they do. Try and copy these View settings, as things like Clouds, Soft-

Water and Macro-Texture are unnecessary and will only slow down the 

program. You can toggle these any time you like, and you’ll still be able to 

see these things in-game. 

 

At the bottom of the window, you can see info like your Object count, XY 

coordinates and number of selected objects. 
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Creating a New Map: 

Select “New Map” and enter your desired size. Map sizing can be tricky, 

and it usually takes experience before you can enter a size that will work 

well, first time. Maps don’t have to be square, and are usually a size 

between 250x250 and 500x500. Try and avoid excess space on your 

map, especially near the edges. Extra empty space won’t get used by 

players and it’s only going to be more work for you to create terrain, 

texture and place objects there. 

 

Although the border is not seen in game, it is still very useful whilst 

making the map. Usually, 30-80 ft is a good size. Always have an initial 

height as well so that you can put any rivers or lakes in. About 30-50 is 

good, make it higher if you plan to have a map with bigger differences in 

height. When you change terrain, it is easier to build up, rather 

than take down 

 

 

Resizing: 

If you later find that you need to resize your map, but you don’t want to 

restart, you can use the Resize tool (File>Resize…).  

 

Enter the new desired size. The “Anchor” is the area on your current 

map that the new size will ‘spread out’ from. Eg if you needed to extend 

the right section of the map, and the left side was fine, you’d select the 

middle-left anchor position. 

 

Be careful when resizing. It’s a good idea to change the size a little at a 

time, maybe about ±50 ft.  

 

 

 

 

Borders: 

If you select “Show Map Boundaries” and “Show Impassable Terrain” 

(CTRL+I), you will see a blue dotted line and an unbroken orange line. 

 

The blue line is the full border of your map, and can only be changed by 

resizing your map. The orange line is a changeable border, and can be 

used to limit players’ movement on the map. Generally, I keep these 

two borders the same size, but you may have to change your border if 

you have resized your map. 

 

To change the border, click the Border button on the toolbar. When 

selected, you can click and drag the orange border to suit. The bottom 

left corner is anchored and will not move. If you want to extend in 

this direction, resize your map. 

 

You can create a new border (usually for scripting) by clicking and dragging from the bottom left 

corner.  

 

I also find it useful to paint a black border around my map, using the Lock Angle and Large Tile tool. 

Usually about 5 or so tiles outside the border, this helps me to see where the extents of my map are, 

when terrain and camera angles can distort my view of the orange border.
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Setting Up Your Map: 
It’s a bit tedious, but you’ll have to edit some things first, before your map will work properly. It may 

seem a lot at first, but once you know the steps, it’ll only take a few minutes. 

 

Setting up Players: 

First, you need to edit Player Lists, and Teams. Open up “Player List” (CTRL+ALT+P), click “Add 

Skirmish Players” and press OK.  

 

Next go to “Edit Teams” and click “Add New Team” under PlyrCivilian. You need a new team for each 

of the players on your map. Name each of these new teams “Player_X_Inherit” (without the “ ”), 

where X is the Player Number. 

 

 

I also like to get the Map Settings bit done at the start (Edit>Edit Map Settings). Here you enter the 

map name, (what is displayed in game), as well as the Time of Day and the map description.  

 

The map description should not be too long, and it is also a useful place to give yourself credit as the 

map maker (maps are often distributed around the web). To add a new line, press CTRL+ENTER, so 

you can add the map stats (Number of Players, Starting Positions, Expansion Points, Settlements, 

Lairs). 

 

The Time of Day can be changed here, or you can use CTRL+D at any time. It’s nice when it matches 

your loading pic, but doesn’t have to. Choose one for now, and you can edit the “Global Light Settings” 

later if you want.  

 

It’s a good idea to save at this point. Save it under the User Maps tab, and name it whatever you 

want. Keep saving regularly in WB, as it often crashes when memory nears full.  

 

Seriously. Keep Saving. 
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Bases and Settlements: 

Once you’ve done the Players and Teams, you can add Castles, Camps, Outposts and Economy Plots to 

your map. Using the Place Object tool, add bases and settlements to your map, following the 

concept you made earlier. It’s a good idea to switch to “Top Down View” (CTRL+F) and zoom out so 

that you can see the entire map, and place your objects evenly. 

 

 

 

All the starting bases are found in “Civilian”, under “ByNativeType”. Castles and Camps are suffixed by 

a direction (eg CampFlagSE), which is the direction the front of the castle/camp will face. Outposts 

(“ExpansionFlag”) and Settlements (“EconomyPlotFlagMultiplayer”) only have one direction. Do what 

they say and don’t rotate them.  

 

Each starting bases will need to be name “BASE_FLAG_X”, where X is the player number. They also 

need to belong to “PlyrCivilian/Player_X_Inherit”, with the same player number. Select the object 

and type in the name. Choose the correct team from the drop down list in the Object Properties 

window.  
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If you have Expansion Points (like outposts or camps) that aren’t going to be owned by a player at the 

start of the game, name them “BASE_FLAG_X”, but make sure “X” is a number that does not belong 

to a player. Place them on team “PlyrCivilian/teamPlyrCivilian” (eg If I had an extra outpost on a 2 

player map, I would name the outpost “BASE_FLAG_3”.) 

 

Settlements must be named “ECON_FLAG_X” with “X” from 1 to [however many settlements you 

have]. Give them to “PlyrCivilian/teamPlyrCivilian” 

 

You also need to give each player a waypoint. Using the Waypoint tool, place a waypoint near the 

centre of each base. Using the drop down list, name it “Player_X_Start”, making sure again that the 

“X” corresponds to the “BASE_FLAG_X” number, and the “Player_X_Inherit” number. 

 

 

Creeps: 

It’s a good idea to place creeps at the same time as your bases, as they affect balance and the early 

game quite significantly. Giving player more creeps, or different creeps (eg trolls instead of goblins) can 

definitely make a difference to balance. 

 

Creep lairs are found in “Structures” under “Neutral”. You only need to place the lair. Make sure the 

creeps are on “PlyrCreeps/teamPlyrCreeps” or they won’t work. 

 

Creeps are best when placed near places of interests, like outposts, settlements or choke points. Don’t 

place creeps too near starting bases (especially trolls), as getting your base attacked within the first 

minute of the game really isn’t fun. Creep lairs also drop treasure randomly, and nothing stops treasure 

dropping up the side of a mountain, into the sea, or inside some rocks. Give the lairs some space. 

 

 

Layout: 

It may also be useful to paint a few guidelines on your map, much like you did with your concept. 

Rough outlines of where rivers, cliffs or terrain will be, will make the whole process easier.  

 

Use any texture you want at this point, as you’ll be removing it before you start texturing for real. 

Leave the original grey texture as it is. Texturing later on will be easier if you do. 

 

 

 
I did decide to put in a shallow river, as you can see. 
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Terrain: 
Sorry about all that boring stuff, but it’s important to get it right (and most common problems are fixed 

if you follow that process right). But now the fun part: 

 

Adding Realism: 

Terrain is very important to get right, in order to make your map as realistic as possible. Terrain can 

also affect balance and gameplay. Some useful tips to remember about terrain: 

 

1. It is often hard as a beginner to get a sense of scale in WB. You can place a temporary structure like 

a barracks to help you judge how large things will be in-game. Double clicking your mouse wheel will 

take you to roughly game height. You can alter camera settings, but it can often cause problems if you 

do. Insanely tall mountains aren’t cool, they’re annoying. Be realistic with your heights. 

 

2. Generally, the terrain should never be completely flat. In reality, the ground is always sloping, and 

even desolate plains, barren deserts, and urban cities have angular terrain. This doesn’t mean you 

should have mountains everywhere though. Using a high feather value and smoothing the terrain to 

make low mounds will make the whole place a lot more realistic. The only large areas that should 

be completely flat (generally speaking) are the areas underneath bases/plots. The effect of 

the camera raising and lowering on gentle uneven terrain is enough to (subconsciously) make a map 

feel realistic. 

 
 

 
My Eryn Vorn map still has sloping terrain, despite it being a forest map with no cliffs. 

 

 

3. 95% of the time, players keep the camera in the default position. Where terrain is concerned, 

it means not creating tall cliffs in front of things that you want you players to see. If you do need to 

place things like creeps behind tall cliffs, try smoothing the terrain a bit at the cliff edge, or creating a 

chunk out of the cliff line. 
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Basic Terrain: 

There are several tools that you’ll need when making terrain. On the toolbar from the left, there’s the 

Height Brush, Mound/Dig tools, and the Smooth Height tool. When creating your terrain, it’s a 

good idea to start off by laying out the basic heights of your map. 

 

Using the Height Brush (with a size of about 15-20, a little bit of feather and whatever height you 

need), form the basic shape of your map’s terrain. 

 

Once you’ve done that, use the Smooth Height tool (you’ll need a fairly large size) and smooth down all 

the edges of your terrain.  

 

Use the Mound and Dig tools (with a small size, but large feather) to adjust the terrain some more, 

adding height in some areas, and then smooth them down again. I add a bit of height around the areas 

I originally mapped out, to make the slope change less obvious. 

 

At this stage, don’t worry about getting it perfect, or about the terrain intersecting plots, as it’s only 

rough and is going to be built on later. 

 

Have you saved it yet? You should have… 

 

You can use CTRL+I to see 

impassable areas on your map, so 

you can smooth down terrain more if 

you need to. 

 

Now that you have the basic terrain laid 

out it’s a good time to test your 

map.  

 

This lets you see how the scale of your 

terrain is, and whether or not you need 

to make changes to your map. It also 

lets you check that bases and plots are 

working okay.  
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Finalising Terrain: 

Once you’ve tested, and adjusted anything you need to, it’s time to make your cliffs look a bit more 

realistic. 

 

You may also want to remove the textures you painted in before. It’s up to you whether you think you 

still want them as a guide. 

 

Select the Mound tool, and set the size to quite small (around 5-10 is good). Set the feather width 

depending on how rocky you want your terrain to be. The more jagged you want it, the smaller 

feather width you should use. Just quickly move it over the edges and sides of the mountain and 

watch the bumpy ground build up. Again, smooth down the edges according to how rough you want it. 

 

Once you’ve done this for the whole map, add some minor terrain rises in for any flat terrain you have. 

Using the Mound tool with a high feather size, gently add some terrain to any flat expanses of land you 

have. Smooth it all down. 

 

 

Now you’ve done that, it’s time to clean up the terrain around plots (like the settlement in that screen 

above). Using the Height Brush tool, level out the terrain so that it’s perfectly flat under and around all 

the plots and creep lairs. It’s quite annoying to see bits of terrain poking through your castle floor in-

game. 
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Objects: 
Whenever you place or select an object, it will bring up the Object 

Properties window. This window controls everything about that 

object, and is very useful in creating interesting arrangements of 

objects. 

 
You won’t really have to name objects unless they are plots, or you 

are scripting your map.  

 

The team of your object is important, but most objects are fine 

under their default team. 

 

Other settings are: Enabled (can move and respond to the 

environment), Unsellable (object can’t be sold off), Targetable 

(can be targeted by enemy units), Indestructible (duh), AI 

Recruitable (can be recruited to do things by an allied AI player), 

Powered (can animate and do things – if it’s not powered, it can’t 

do anything), and IsSelectable Override (object can’t be 

selected by a pointer – recommended for scenery like trees). 

 

You can also edit the Targeting Distance and Shroud (amount of 

shroud the object reveals). 

 

The Z position is used for raising or lowering objects. You may 

want to bury an object to hide parts of it, or to give it a more 

ruined look. Be careful when doing this, as units will still 

manoeuvre around a sunken object, even if you can’t see it. 

The sliding bar will only go to ±50, but you can type whatever 

value you want. 

 

Selecting the Scale box and changing the scale is also a useful 

tool, for creating unique maps. Large scale objects can be 

interesting and add new views to average objects (such as trees, 

ruins, rocks etc…). Be careful when scaling though, as units will 

treat scaled objects as if they weren’t scaled. Ie units will 

walk through large scaled rocks. This can be fixed by painting 

areas impassable (see Passability and Taintability). Large scaled 

objects also become more stretched and pixelated. 

 

The Align to Terrain box is a cool option to use when you don’t 

want an object to be perpendicular. Using this can really give 

objects a ruined look, or correct objects that stick out the ground 

on steep terrain. 

 

Initial health can be changed for gameplay purposes, or to give 

structures damaged states. The other stats you can change include 

Max HP, Aggressiveness and Rank. 

 

The Sound options aren’t used a lot, but can be edited if you want 

to change an object’s default sound, or sound settings. 

 
I increased the volume and range of a scaled-up waterfall I placed in my 
Argonath map, to give it a louder roar. 
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Trees: 
I’d suggest putting in trees now, as they will help with your texturing, and are needed for lumbermills. 

 

There are many types of trees under the SHRUBBERY menu in the Objects List. You should already 

have an idea of the types of tree that will be suited to your map, so it’s just a matter of finding the right 

ones. 

 

You should have a variety of trees – not too many and not too few. BFME will have a memory error if 

there are more than 14 different tree types on a single map. You don’t need that many anyway, it’s 

unrealistic. Around half a dozen types is a good number. Choose a selection of trees that 

compliment each other well. There are a couple of ways of filling out your map. 

 

1. You can use CTRL+C to copy and CTRL+V to paste clumps of trees around your map, and change 

them accordingly. Don't leave in their copy-and-paste position unless it looks good. 

 

2. You can use the Grove tool, to randomly place up to 5 

different types of shrubbery. Edit the % values and the Total 

Tree Count to suit your needs, and then click and drag a box on 

your map. You can also click once, and only a single tree will be 

placed. 

 

Using the grove tool is good, as it will randomly change the 

angle and scale of the trees that you place. However you are 

limited to a maximum of 5 tree types at any one time. 

 

Using a mixture of the two methods usually gives the best 

results. It’s important to try and randomise objects though, as 

repetitive objects (including type, angle, scale and 

placement) look unnatural and unrealistic. 

 

This tool can also be used for shrubs and grass (more on those 

later). 

 

Things to remember as you place trees: 

1. Economy plots should always have trees near them for lumbermills. Even barren wastelands or 

snowy mountains should have trees near economy plots (though dead ones and stumps usually) 

 

2. Dense clumps of trees are bad for pathing, and there should be enough room between clumps of 

trees for units to walk. 

 

3. Try to vary your density of trees and have 

good layout, as dense clumps look bad if there 

are no other clumps near, and single trees look 

bad if there are lots of other single trees nearby.  

 

4. Make the most of your objects, by placing 

them where they can be seen. Players don’t 

change the camera angle often, so objects that 

are obscured by terrain or larger objects will 

only cause lag. That doesn’t mean spread 

them out to much though, some clumps are 

good.  

 

5. Think about it. There should be plenty of trees 

near rivers and lakes, not so many on mountains 

or paths. 
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Water: 
Water on a map can add a dynamic visual aspect, and also create interesting gameplay through 

crossing points. Doing the water now can help with your texturing (so you can see exactly where you’ll 

have to texture river banks and such). 

 

Adding water in BFME 2 is quite different to BFME 1. I’ve included a link to an excellent tutorial 

(see Credits and Resources) for all you BFME 2 mappers out there.  

 

Using the Water Tool: 

Using the water tool is very easy, just select the tool and plot your points where you want your water.  

 

There are several settings when it comes to water, to help 

you get the right look. 

 

Max Alpha Depth and Deep Water Alpha are generally 

used for lakes and oceans. These give your water a fading 

effect near the water surface, depending on their values. 

 

Tick IsRiver if your water is a river. This lets you edit the 

River Specific Options instead of the Lake/Ocean 

Specific Options. 

 

Water Height is quite obvious really. Make sure your river 

sections are the same height. UV Scroll Speed is how fast 

the water is flowing (higher number means faster). You don’t 

need Additive Blending, but it sometimes can help you to 

see things under your river as you are mapping.  

 

Alpha is basically how transparent your water is. An alpha of 

0 makes your river invisible, 255 will be completely opaque.  

 

Depending on your PC, you might not be able to view 

water alpha at all. You can still estimate, or you can get 

other mappers to have a look for you. 

 

The Color <RGB> settings change the colour of your river. 

The River Texture option can also change your river colour 

to a variety of different default settings. 

 

The Bumpmap Texture and Sky Texture are used when 

you don’t have the IsRiver box checked, and are the only 

way to change the colour of lakes and oceans. 

 

Lakes and Oceans: 

Lakes are easy. Use the tools, plot the points. And for the love of God change the settings! The default 

blue colour is bloody hideous. You’ll only be able to change the alpha settings and textures for lakes, 

but muck around until you find what you're happy with for your map.  

 

 

Rivers:  

Rivers need a minimum of 6 points. Make the points in the following way (with the arrow 

indicating the downstream). Then check the Is River box. 

 

Sometimes it doesn’t quite work the direction you want. If so, play around with the 

position of points until it flows the way you want. You might find it easier if you move you 

river outside the map, so you can see it clearer. 
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Make the rivers the size you want them, try not to upscale them afterwards as this can reduce the 

quality. 

 

River edges should not touch the bank. Seems silly, but the river edge has a fade effect (called soft 

water) which only is visible if your river boundaries are slightly inside the river bank. 

 

Have a play with the Alpha, RGB and Texture until you have a nice look. A good alpha for your main 

(unfordable) river is about 170-200, but it also depends on how shallow the river is, and how clear you 

want it to look. 
 

 
A ford in The Carrock, by BadMadMax, with the fords by m@tt.  
Courtesy of m@tt’s How to Make an EA Quality Map tutorial. 

 

Fords:  

Fords can be a little tricky to get right, but are relatively simple once you get the hang of things. 

 

Fords will usually look better (and be obvious as fords) if they have a higher transparency than the rest 

of your river. The easiest way to do this is to give your ford a separate river area. For water to be 

walkable, it needs to be less than 7 units above the floor. The rest of the river should be the 

same height (so there aren’t any vertical gaps between the river sections), but you can paint the rest of 

the riverbed impassable to stop units going there, or you can just make that bit deeper.  

 

Aligning the separate river sections exactly can 

be tricky, but if you place the object icons (black 

points) exactly over the top of each other, they 

should line up perfect, without any gaps or 

overlapping. Using CTRL+F can help you see 

when doing this. Change your ford’s alpha to a 

lower value, probably around 130-150. 

 

You’ll notice that the change between the 

different alphas is quite noticeable, so you’re 

going to have to place some props to cover it 

up. You can do this now or later on. Big 

rocks are great, but use a variety. Adding 

ruined structures, fallen trees and grass can also 

help make it look natural (see Props for more). 
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Texturing: 
Texturing is where you can really make a map stand out visually, and it is often the difference between 

a great map, and a poor map. It’s probably the most interesting part of mapping, but it’s probably the 

most time-consuming, and hardest to get right. Don’t give up if it doesn’t work out the first time. 

Keep trying. 

 

I’m going to include a few different methods for texturing in this tutorial – the method from m@tt’s 

tutorial and my own, different way. It might be that you find another way or order of texturing, 

or a combination of methods that works for you. If so, stick with it, and keep practising! But first… 

 

 

Tools: 

There are several tools to help you texture. There are the Single Tile, Large Tile and the Fill Bucket 

for painting, and the Auto Edge In and Auto Edge Out tools for blending. You can also hold ALT at 

any time to use the Eyedropper tool (or select it from the toolbar). 

 

When painting terrain with the tile tools, you can select up to 2 textures (foreground and background). 

This can be useful if you find yourself switching from a couple of textures quite often. When using the 

fill bucket, you can hold SHIFT and click, to replace all instances of a texture, with your chosen one. 

 

Generally, you will probably use the blend out tool rather than the blend in tool, as the results are 

usually better. If neither of these tools gives you the look you want, you can use the Blend Single 

Edge tool, to manually blend each tile. Doing this is time consuming, and is usually only used (with the 

single tile tool) to fix dodgy squares that haven’t blended right. 

 

There shouldn’t be any reason to leave unblended tiles on your map. Blending is time 

consuming, and will be cleaner and more efficient if you have to blend fewer areas. 

 

Have a play with these tools so you’re comfortable with them, before you start texturing your map. 
 
 

Areas: 

So hopefully by now you have your map with completed terrain, most trees, and possibly water. Before 

you start texturing, it’s useful to make a grid of all the textures you plan to use on the side of your 

map. Have a play with some of the textures until you have a nice range of textures for different areas. 

It’s really important that your textures for each area are similar, and blend well. 
 

This is from m@tt’s tutorial, of his Old Ford of Anduin map. 
G = Grass, P = Paths, C = Cliff, B = Beach, F = Ford, R = Riverbed. 

 

There’s nothing worse than a good map that looks 

monotextured, so make sure you use a variety of 

textures. It takes a while, but it makes the world of difference. 

 

One thing you may want to do straight away is remove all that 

default grey texture. DON’T!!! The grey is your friend.  

 

To start off, separate all your areas that will be differently 

textured. So things like cliffs, rivers, or dense forests. 

 

You may want to add a path into your map, between places of 

interest (like bases, outposts, settlements, or through forests). 

It really depends on where your map is based, and if it’s logical 

to have a path there. A well travelled area like the Gap of Rohan 

probably would have a path, but not in a barren Harad desert. 

Use common sense. 
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So here’s my Forlindon map, with trees and water in, and with areas separated (I’m not adding a path): 

 

 

I’ve also painted patches under creep lairs. You don’t have to, but it can give players a hint if they 

haven’t played your map before. Just choose a texture that blends nicely with your other textures. 

 

If you do add a path, here’s how to do it (from m@tt’s tutorial): 

 

Paths should have 2 or 3 textures – one main texture, one texture between the path and grass (so the 

change isn't unrealistically obvious) and maybe a third for little spots on top of the main texture.  

 

Start by outlining the linking texture (size 2 brush; try to make the gap at least 2 as well). Avoid 

straight sections and have paths going to important points on the map (like bases, neutral buildings, 

fords etc). 

  

As long as the path is completely enclosed, you can use the Fill Bucket to fill in the main texture with a 

few clicks. Do not blend (yet). Add your third texture if you have one.  
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Once you’ve done any paths, move on to any rivers or water you have. 

 

For rivers, have a base texture of either dirt or smooth rock/cliff. It's difficult to see through water, so 

the different textures won't be that obvious, but you still don't want it to look flat. Blend out the second 

texture when done. Add another rocky texture and blend. 

   

For fords, follow the same process, but use a large number of textures – as the ford will be more 

transparent, and texturing will be more noticeable.  

 

Now I’ll show you a couple of different ways to texture large areas on your map, and your method will 

probably determine the order that you paint and blend things. First, we’ll take a look at m@tt’s method.  
 
 

m@tt’s Method: 

m@tt’s method essentially involves painting isolated patches of various textures, and then blending 

everything with a surrounding, base texture.  

 

 
I’ve used some contrasting textures here just to illustrate 

 

 

Doing it this way is easy to control, and prevents dodgy blends. It also lets you use a larger variety of 

textures, and will give good results if you have chosen your textures well: 
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So now that you’ve done any paths or rivers, you can 

do any cliffs you have.  

 

For small bits of cliffs, just use one or two textures 

(cliffs or rocks) and add to where-ever you want and 

blend out.  

 

For large areas, you need more textures or else 

it will look monotextured.  

 

 

The texture you used to paint around your cliff with will be your base texture. Choose 3 or 4 others, 

and paint random shapes into the area. As these areas are usually quite small, try and paint small 

shapes (about a size 2 brush is good).  

 

Avoid having them touching, as blending will be easier if they aren’t. 

 

Now reselect the base texture and use the fill bucket to fill in the grey on your mountains. Then blend-

out the base texture.  

 

 

The process is very similar for the main land. Pick a base texture and several other (4ish) secondary 

textures and maybe a handful of others that only appear every now and again.  

 

Using a similar technique to what we've just seen, paint your shapes with the size 2 brush. Paint much 

larger shapes, keep the gaps small, and do not blend.  

  

Because they are bigger, you can add another texture on top of your patches (don't touch the edge). 

You can blend these inner textures.  
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Once you have some variety, select the 

base texture, fill it in and blend it (the base 

texture). That will blend all the big shapes 

and will save you a bit of time.  

  

 
This example was for a closed bit of land, but with 
large areas this can still be very time consuming. 
Stick it out though, because making an effort 

is worth it.  

 

If you don't like the look (the base texture 

got switched after taking the screenshots), 

it is easy to repaint. Just fill in a texture 

with another one (hold SHIFT and replace 

all instances).  

 

When done, you can then blend all the 

unblended bits, such as your paths 

 

 

When fully done... 

 

 
This is Old Ford of Anduin, by m@tt. A good selection of textures will give you very good results 
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Haldir’s Method: 

My own method differs for painting large areas of terrain, and the order that I texture in is different 

because of it.  

 

First I fill in a base texture, and then I draw a series of “squiggles” with a single tile across my base. If 

all the squiggles are joined, then it only takes one click to blend. I then repeat for a couple of other 

textures. 

 
 

 

Again, high contrast so you can see. 
 

Doing it this way lets you texture large areas in a very quick time. However, it will often lead to dodgy 

blends (as you can see). Because of that, you are limited to about 3 or 4 textures (1 base, and a few 

secondary ones), which all have to blend together really well.  

 

The more different they are the more obvious bad blends will be, and the more time is spent 

trying to fix them. 
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I use the same process as m@tt for texturing paths and riverbeds, so we’ll just move on to cliffs: 

 

Select the base texture for your cliff area – it can be the one you used to paint around the edge, or a 

different one. Fill in your cliff, and blend if you are using a different edge texture. 

 

Now, select another similar texture, and paint a bunch of squiggly lines over your base texture using a 

single tile brush. Concentrate on breaking up the pattern of the base texture. Try and make sure 

this second texture is unbroken, so that you can blend the whole texture with one click.  

 

 

Choose 1-2 other textures (depending on your textures, and the size of the mountain), and repeat. You 

should soon have a fully textured mountain. 
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The process for texturing the main land is pretty much the same. Fill in a large area with your base 

texture and blend out: 

 

Now, take your first texture and start drawing random squiggles. Try and keep the pattern random and 

avoid long straight lines. Blend it out. You can hide stuff like Objects, Grass or Water if it helps you see 

what you’re doing.  

 

It may take a bit of playing around to get your textures right, but be patient and keep at it. If you 

decide to change your textures, just use the paint bucket to replace all instances of a 

texture. Blend out your texture when you’re done. 

 

 

Repeat the squiggling with your next texture, 

focussing on disrupting the lines of your first 

texture. Your textures will be less noticeable if 

they are in patches, rather than lines. Blend it 

out. 

 

Don’t stress if you happen to notice some bad 

blends. Depending on how noticeable they are, you 

could consider swapping textures. 
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Have a look at your texturing. If your blending is still lacking or not to dodgy, you could possibly add a 

third or even fourth texture.  

 

Once you’ve finished with your textures, you can use the single edge tool to fix any bad blends. You 

might want to retexture your area if the blends are tricky, or there’s too many to do by hand. If there’s 

way too many, you might want to swap a texture over, as bad blends are more obvious with 

contrasting textures. 

 

 

 

You may also want to add some finishing touches to some other areas. Ruined cobblestones under ruins 

or bases, or an extra foliage texture under dense forests can help create some variety with your 

texturing.  

 

Just keep working at it until you’re happy. Don’t be afraid to paint it blank again to get the 

results you want. 

 

 
Here I’ve added 2 other textures to forest areas, to add some variety 
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Forlindon fully textured – though in this screen you can’t see most of the trees. The squiggling is less obvious in-game 

 
 

Cliff Texture Mapping: 

If you find that you have a sheer cliff, and your texturing is really stretched, you can Map Cliff 

Textures (under Texture Sizing), to make them look a bit better. 

 

Choose the cliff texture that you want, and then point to your cliffy area with the Map Cliff Texture tool. 

The tool will retexture any stretched areas, so that the texture conforms to the terrain. If you decide 

you want to change or remove this look, select Remove Cliff Tex Mapping, and it will remove it from 

your map. 

 

Though it looks good, there are some limitations. You can only have one texture that you can use 

to map your cliffs. If you want another cliff to use a different mapping texture, you’ll have to remove 

the first one. Also, you won’t be able to blend textures, if one of them is mapped onto a cliff. To 

get around this, simply texture a bit wider around your cliffs before mapping the textures. 
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Passability and Taintability: 
It’s important to paint areas on your map according to whether they are passable or taintable. You can 

use these options by selecting them whilst using a single or large tile tool. You’ll need to show 

impassable terrain (CTRL+I) to see where you’re painting. 

 

 

 

Passability: 

Terrain will automatically be impassable if it is at a 

certain angle. You may need to clean up these 

areas though, or block off areas that you want 

inaccessible. It’s very easy to use, just select 

Impassable from the Passability options, and 

paint where you need to. Don’t worry about the 

Impassable to Players or Extra Passable options. 

You’ll never need to use those. 

 

Make sure you paint all the areas you need to, like 

mountains, rivers or large scaled objects. Don’t 

leave ‘islands’ of passable terrain in your 

impassable areas either. This is better for 

pathing, and prevents units (like summons) from 

being trapped there.  

 

It’s also better for pathing if you paint blocky 

shapes, rather than having small fiddly bits that 

units have to walk around. Cleaning these areas 

and any stray tiles can make your map run a lot 

smoother in game. 
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It’s never a bad idea to paint a strip of impassable terrain around the border of your map. 

 

 

 

 

Taintability: 

Painting an area Not Taintable will prevent most special powers (like summons or land taints) from 

being cast in an area. Generally, anywhere that is Impassable, should also be Not Taintable. 

This prevents units from being summoned, and not being able to move anywhere. You can be a bit 

more lenient with your painting, but letting an elven wood spring up on steep cliffs, or summoning units 

into the ocean is just silly. 
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Props: 
Now that you’ve finished texturing, you’ll need to finish adding props to your map. Objects like rocks, 

grasses and bushes, animals, ruins and water effects will all help your map look and feel realistic.  

 

Natural Features: 

Add rocks to your map first. If you haven’t already, you should add some rocks around fords and rivers, 

to help disguise the ends of rivers. 

 

Have a play with scale and angle, to create nice looking scenes. There’s no right way to do this, just 

play with the different rock arrangements until you find what you’re looking for.  

 

There are 4 different sets of rocks, the DarkRockGrey, EdorasRock, MordorRockClump and 

RockGrey types. Generally, you should probably stick with one set. Choose the rocks that match 

the colour of your cliffs, as the rock type of a region should mostly be the same. 
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If you find that some rocks are floating off the ground, you can use the Align to Terrain box to tilt them 

downwards. You may need to paint some impassable terrain around some of your rocks, 

especially if you’ve scaled them up. 

 

Shrubs are much the same. Like your trees, you can choose whether you copy and paste, or use the 

grove tool. I like to use the grove tool, but I place shrubs individually rather than in clumps. With a 

selection of shrubs that suit your map, use the grove tool to click on spots that need some grass. 

 

Shrubs tend to look out of place if too many are placed by themselves. Place shrubs around 

areas that grass would tend to clump around. Rocks, cliff edges, ruined structures and large trees look 

good with some shrubbery here and there. Once again, just do what looks natural. 

 

Animals are easy to place and will definitely help your map look realistic. Just think about what sort of 

animals would live in your region. For example, placing a wolf on a desert map or some cows on a 

snowy mountain just doesn’t make sense. Use a variety, but not too many. 
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If you have a river on your map, it’s a good idea to place some water ripples along your current. Water 

ripples will just add to the realism of your map, and make your rivers more interesting. The best object 

to use is the WaterRipples object found under MISC MAN-MADE.  

 

 

 

Realistically, ripples are created by water flowing past a solid object, such as rocks, ruins or fallen trees. 

Place them so the start of the ripples is covered by the object. Make sure you use a variety of sizes 

and angles, otherwise it will look unnatural.  

 

Also, you’ll need to adjust the height of your ripples so that they sit just above the water level, and 

not on the river floor. Otherwise you won’t be able to see them. 
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Man Made Features: 

Adding structures and buildings to your map can 

also add to the look of your map, and bring 

certain regions to life. Your inspiration and 

planning should help you decide whether you want 

to put in any ruins, and what type or how many 

there should be.  

 

It’s up to you when to place your structures 

– maps with bridges or many structures 

probably should have buildings placed earlier 

than other maps. 

 
My Lond Daer Enedh map had lots of ruins, so I placed 
them even before texturing and other props.  

 

Think about the region of your map and who lives there. Your map might include farming villages, orc 

tents, Elven statues or crumbling walls. I’m only choosing to add a few Elven ruins to my map, as it’s a 

largely uninhabited area.  

 

 

You can also use the Road tool to place man made features on your map. Select a type of “road” from 

the list, and click and drag your mouse. You can link up different sections of road to create vehicle 

tracks, pavement, or just footprints in the dirt. 

 

Don’t overlap roads with plots, as the road will show up on top and look dodgy. 

 

 
A few footprints around a camp on my Eryn Vorn map helps to add realism to the campsite. 
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Audio: 
Add some sounds to your map, to help it feel realistic. All the sounds are found in the Audio folder 

under Civilian. If you place them on your map and then select them, you can use the sound options to 

listen to them. You can also adjust the volume and range of the audio if you want to. 

 

Think which places on your map are noisiest, and add audio there. Try and have some audio 

everywhere on your map, even if it’s just some wind, cricket chirping, or bird calling.  

 

Whatever works, just use common sense which sounds you put where. 

 

 
Lighting: 
You can edit the time of day of your map using CTRL+D. However, you can edit the light settings a bit 

further by editing the Global Light Options (Edit>Global Light Options). You can play around with the 

settings and angles of the various light sources, until you have a look you’re happy with. You can 

restore the settings to their default if it doesn’t work out. 

 

Keep in mind that you want players to be able to see properly, so don’t shadow your map so much that 

you can’t see your units or the terrain. Also, whilst long shadows and dramatic lighting looks nice, it 

takes up a lot of the games’ memory. Try and keep your shadows shorter. You can create nice light 

effects, without slowing down your map.  
 

 

 
My Eryn Vorn and Withered Heath maps have unique and dramatic lighting effects, without taking up heaps of memory 
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Tactical Markers: 
It’s a really good idea to add AI tactical markers to your map. AI players do function without them, but 

pretty poorly. Adding markers takes no time at all, and will seriously improve the AI gameplay on your 

map. Markers need to be placed near each base, and can be found in the AI folder.   

 

First, you need to place 3 markers each for a Center, Flank, and Backdoor path. Each of these paths 

has three different markers (eg Center1, Center2 and Center3). These are all found under TACTICAL 

MARKERS in the AI folder. 

 

To set your markers for a Center path, arrange your three markers in a line leading to the base, with 

Center1 closest to the base. AI will move from Center3, to Center2 and then to Center1, before 

attacking.  

 

Repeat this for your Backdoor and Flank paths, but give them a different direction or route. Make sure 

these 9 markers are on the same Player_X_Inherit team as the base they’re near. 

 

 

You should also add the 10 “CombatArea” markers to your map. It’s important to add all of these 

markers to your map, even if they overlap a bit. AI gathers at these areas to fight, so place them in 

wide open spaces, and away from castles or camps. Add these to the “PlyrCivilian/teamPlyrCivilian” 

team. 

 

Tactical markers for Forests, HighGround and ChokePoints are also placed on the Civilian team, and 

help the AI choose where to move, attack and defend. ChokePoint markers work best when there is a 

marker on each side of the choke point. 

 

Generally, the more markers you put in, the more varied your AI will be.
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Basic Scripting: 
Scripting is mainly used for single player maps, or it can also be a useful tool when adding special 

features to your map. 

 

You can open up the scripts window by clicking the “Scripts” button on the toolbar. Create new scripts 

by selecting the player you wish, and pressing “New Script…”. Scripts that affect all players are 

usually under the Civilian folder. 

 

When you edit script, you will see a number of tabs. The Script Properties tab allows you to edit 

whether the script will Deactivate upon success, or if it will constantly Evaluate itself.  

 

 

Scripting works on a conditional system, where a cause (IF) triggers a given effect (THEN). The Script 

Conditions tab will let you edit the conditions, or the “IF”. You can edit the script conditions, and also 

add other conditions using the AND and OR buttons. “IF True” means that the script’s effects will 

always run. 

 

The Actions if True and Actions if False tabs are the effects of your script conditions. Edit these to 

create your desired effects. 

 

Editing scripts is simple, and the best way to learn about them is to experiment for yourself. To edit a 

script condition or effect, click the Edit… button with the condition/effect highlighted. You’ll see a large 

drop down list of options that you can choose, and then click to edit. 

 

If you want to refer to a specific object in a script, you will need to give that object a name in its object 

properties.  
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Some easy, common multiplayer scripts include restricting certain units or buildings, revealing the map 

and changing the starting resources.  

Here’s an example of a script to reveal the map: 

 

*IF*  True. 

*THEN* The world is revealed permanently for Player ‘<All Players>’. 

 

Tick “Deactivate upon Success”, and evaluate the script “Every Frame” 

 

The best way to learn is just to experiment. There are a few other tutorials on scripting that are 

more in-depth (see Credits and Resources), or you can ask in the T3A forums.
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Map INI’s: 
Sometimes, what you want for your map may not be possible using WB alone. You may need to make 

an INI file for your map. Rob38 has written an awesome tutorial on map.ini’s (see Credits and 

Resources), which explains some basics: 

 

A map.ini is a file located in your map folder that allows you to change parts of the coding in the game 

for your map only.  

 

WB is an amazing tool but there are many things that can't be edited with it. By creating a map.ini, you 

can create new FX, edit powers and stats, make custom spellbooks, and so much more. Essentially, you 

can create a mini mod for your map, to make your map more unique and creative. 

 

To create a map.ini, open up a text program like Notepad, or WordPad. Save the file in the same folder 

as your map, and call it “map.ini”, without the quotes. 

 

To edit and copy code, you’ll need the FinalBig program (which can be downloaded at the T3A site), 

and enough knowledge to extract and find the code for given objects –the T3A site offers a bunch of 

helpful advice on coding and extracting from a .big file.  

 

There's really no easy way to explain how to learn to code. You just have to dive into it and learn from 

trial and error. In your map.ini file, you add anything you wish to change or remove for your 

map 

 

Some common uses for map.ini’s include: changing a display name of an object, or making certain 

trees harvestable, or adding weather effects like snow or rain. 

 
There are plenty of articles and map.ini’s available on the T3A site, as well as the T3A forums.  

 

 

On my Iron Hills map, I used a very simple map.ini to change the DisplayName of “Object 
MordorCirithUngolBridgeA” from “Cirith Ungol” into “Bridge”. 



Page 38 of 45 

Mini Map and Loading Image: 
The loading image and mini-map for your map can be edited, and are 

saved as .tga files. You need an image editing program that can save as a 

Targa file, in order to edit these files. Adobe Photoshop CS3 is what I’m 

using, but older versions, or Gimp should work fine too. 

 

Loading Image: 

Your loading image needs to be a .tga file of 128x128 pixels. Simply 

resize your loading image, tweak it if you want, and save it as a .tga file. 

You will need to name it “yourmap_pic.tga”, where “yourmap” is the 

name of your map. For example, my “Forlindon” map has a loading image 

name “Forlindon_pic”. Save this in the same folder as your .map file. 
 

 
Mini Map: 

The process for making an authentic mini-map is different. WB automatically generates a mini-map 

based on your map’s terrain, but it looks like crap. Do a proper one – it doesn’t take long at all. 

 

First, go into WB, and take a screenshot of your map – fully zoomed out in top down view. Next, open 

up Photoshop and paste it into a new document. Crop the image to the map border. 

 

 

 

 

Create a new layer (CTRL+SHIFT+N) and select the paintbrush. Choose the hard edge brush, black 

colour, and choose a brush size. You’ll want to use a couple of different sizes on your mini-map, but 

around a 9 is probably good to begin with. 
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On your new layer, trace around the important land features on your map – such as mountains, 

coastlines and impassable rivers. Using a smaller size (maybe a 7), paint around more minor features, 

like large rocks, ruins or paths. 

 

Select a dark grey colour, and fill in any water you have. If you have fords or shallow water on your 

map, you might want to use a lighter grey. 

 

 
Here I’ve used to separate grey colours to distinguish between passable, and impassable river. 

 

 

If you have large impassable cliffs on your map, you may want to emphasise them so they look like 

mountains on your map. Draw sets of parallel lines on your sections of mountain with a smaller brush. 

 

For impassable water, draw sets of arrow heads in varying clumps across your water. It might be easier 

to draw one arrow head and copy and paste it a bunch of times. 
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Now, create a new layer below everything but the screenshot, and fill it white. Merge down all your 

layers. You should now have a blank looking map something like the one below.  

 

Flip the image vertically, and invert the colours. Resize your image to 128x128 pixels (even if your 

map isn’t square). 

 

Next, you’ll have to move your mini map onto an alpha layer. To do this, use CTRL+A and CTRL+X to 

select and cut the image. Then, create a new layer under the Channels tab. It should be named Alpha 

1 by default. Paste your image onto this alpha layer. 

 

To give the mini map a brown look, you need to select the RGB layer and fill it with the brown colour 

#4c2c01 (R=76 G=44 B=1). You should now have a brown square, with your mini map on the Alpha 1 

channel. 

 

Save your mini map as a Targa (.tga) file, and name it “yourmap_art.tga”. Save it in the same folder 

as your .map file. 

When you run the game, you should now have a nice loading image and mini-map for your map.
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Importing Maps: 
All the maps you create and save go in a “Maps” folder in your “Battle for Middle Earth Files”, 

folder, under “Application Data” (which is a hidden folder). 

 

 

For Windows XP, maps can be found in:  

“C:/Documents and Settings/Username/Application Data/My Battle for Middle Earth 

Files/Maps”.  

 

For Windows 7, the directory is: 

C:\Users\Username\AppData\Roaming\My Battle for Middle-earth(tm) Files 
 
 
“Application Data” is a hidden folder. To view hidden files and folders, go to Tools>Folder Options, press 

the “View” tab, and tick “Show hidden files and folders”. It’s a good idea to create a shortcut of 

this folder on your desktop, so you don’t have to go through this process each time. 

 

To import a map you have downloaded or copied; simply move the map folder (with the map inside) 

into the “Maps” folder.  

 

The map folder has to be named the same as the .map file. For example, in my “Forlindon” folder 

is my “Forlindon.map”, “Forlindon_art.tga” and “Forlindon_pic.tga” files. You can remove maps from the 

game, by removing their respective map folder. 

 

You will also find the MapCache file there. In the MapCache is a list of all the custom maps you have 

made or imported. The file is automatically generated, so I wouldn’t try to change it. However, you can 

change the “no” to a “yes” after “isOfficial”, to make your map part of the Official Maps list, rather 

than the Player Made list in-game. 



Page 42 of 45 

The Next Steps… 
So you’ve finished your map, what now? 

 

Test it. Enjoy it. See how your 

creation has turned out by 

experiencing it in-game. If you find 

anything you don’t like or you want 

to change, change it. 

 

If you think it’s good, put it up for 

download and let others try out 

your map. Put up some screens of 

your map. Take criticism and 

feedback and either change your 

map, or keep it in mind for next 

time.  

 

If you keep practising and improve 

enough, you might be able to join a 

mod team as a mapper, or you can 

just keep making maps for people 

to play and enjoy. 
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Common Issues: 
Here are a number of common issues that appear on the T3A forums. Most of these issues shouldn’t 

occur if you follow this tutorial, but if you’re still having problems you can ask in the T3A forums. 

 

“I can’t find my map in-game” 

First, make sure that you have IsScenario unchecked in you Map Settings. Then, check to see if your 

map is in either the Official Maps, or Player Made Maps lists in game. 

 

If it’s still not there, it probably hasn’t been saved to the right location. Open WB and open your map. 

Is your map saved under the “User Maps” tab? If it isn’t, use “Save As…” to save it in the right location. 

 

“I can see my map in the skirmish map lists, but I can’t play it or select my starting position” 

You probably haven’t placed “Player_X_Start” waypoints on your map. Go into WB and add them. 

 

“My map starts, but I have no base, and I’m then defeated instantly” 

This problem occurs when you have made a mistake setting up your BASE_FLAG plots. Make sure 

they’re all named correctly, and belong to the right teams. 

 

“I have creeps on my map, but I can’t attack them, and they don’t attack me” 

Your creeps are probably on the wrong team. Make sure they’re on “PlyrCreeps/teamPlyrCreeps”. If it 

doesn’t work, try deleting the lairs and placing them again in WB. 

 

“In WB, I can see my objects, but I can’t select, edit or move them”  

Make sure that you place objects using the Place Objects tool, and not the Build List tool. If this is the 

case, you’ll have to delete and re-place your objects. 

 

It could also be that you have “Show Object Icons” unticked in WB. If it’s unticked, you won’t be able to 

select objects. This can be a useful tool when you don’t want to accidentally move things. 

 

“Can I use WB 2 to create a map for BFME 1? Or Visa Versa?” 

No. It won’t work in-game if you try. 

 

How do I play a player made map online?” 

Both the online players will need to have the exact copy of the map. Other than that, it should work the 

same as a regular online game. 

 

“How do I import custom buildings/units/objects into WB from a mod?” 

I won’t cover this in this tutorial, so you’ll probably want to look at the links in Credits and Resources. 

Essentially though, you need to create a new asset.dat file that includes all the vanilla BFME stuff, and 

any new things you want in WB. 
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Credits and Resources:  

 
Credits: 

I would like to thank the following: 

 

EA      for making a great game that I’ve enjoyed for years now. Also, for  

their several WB tutorials that focus on the basics. 

 

m@tt     for his many awesome contributions to the BFME modding  

community. His awesome “How to Make an EA Quality Map” tutorial 

set the standard for mapping, and has helped me and many others 

immensely whilst trying to map. Without maps like his and his easy 

to follow tutorials, I would not be mapping.  

 

Rob38 for his Map.ini tutorial, and for his role in running T3A. Also for his 

work on The Elven Alliance: Community Edition (one of my two 

favourite mods) 

 

Nertea and the TDH team  for letting me join their amazing mod team. The work these guys 

put in is astounding, and is an inspiration for me to keep making 

good quality maps. 

 

Celeglin and TEA for one of the best BFME 1 mods out there. TEA was what led me 

into T3A and BFME modding. Some of the screenshots in this 

tutorial were taken whilst playing TEA:CE 

 

The T3A Community  for their help, advice and praise. It’s for you guys that I’ve bothered 

to make this tutorial. 

 

You      for reading this thing. Bloody hell it was long. 

 

 

Resources: 

Here is a list of a great number of awesome links that have helped me. Hopefully they’ll also help you 

and your mapping: 

 

The 3rd Age Site 

Probably the best online community of BFME modders and mappers. 

http://www.the3rdage.net/ 

 

T3A Worldbuilder Forums 

A forum for people to post questions or topics about WB 

http://forums.revora.net/index.php?showforum=1020 

 

T3A Worldbuilder Tutorials 

A list of all the WB articles on the T3A site. 

http://www.the3rdage.net/itemlist?type=1&category=6 

 

How to Make an EA Quality Map (m@tt) 

The original mapping tutorial, which includes many mapping skills covered here. 

http://www.the3rdage.net/item-311?addview 

 

Beginner’s Guide to Map Making (EA) 

A series of three WB tutorials by EA that cover the basic tools and their functions 

http://www.the3rdage.net/item-93?addview 
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Multiplayer Map Process (EA) 

2 tutorials on setting up maps for BFME1 and BFME2 - including plots, waypoints and tactical markers. 

http://www.the3rdage.net/item-34?addview 

 

Map Beautification Tips (EA) 

A list of tips and advice for making BFME 2 maps. A lot applies to BFME 1 also. 

http://www.the3rdage.net/item-33?addview 

 

Guide to the Water and Atmosphere for BFME2 (Rohara from www.gamereplays.org) 

An excellent tutorial that covers water and atmosphere settings for BFME 2. 

http://www.gamereplays.org/community/index.php?showtopic=106953 

 

Basic Scripting (EA) 

A basic guide to scripting and singleplayer missions for BFME 2. 

http://www.the3rdage.net/item-36?addview 

 

Singleplayer Scripting (EA) 

A walkthrough of the scripting that went behind the Rivendell mission in BFME 2 

http://www.the3rdage.net/item-37?addview 

 

Worldbuilder Manual (EA) 

A technical manual of all the WB 1 tools and functions 

http://lordoftherings.filefront.com/file/Worldbuilder_Manual;59697 

 

Mini Maps (m@tt) 

A tutorial for creating an authentic looking mini-map. 

http://www.the3rdage.net/item-111?addview 

 

Installing Maps (m@tt) 

A short guide on importing maps into your game. 

http://www.the3rdage.net/item-168?addview 

 

Custom Heroes, Buildings and AI for BFME1 (Hebblewhite) 

Two tutorials on importing custom made assets into WB, so you can create maps for specific mods. 

http://www.the3rdage.net/item-192?addview 

http://www.the3rdage.net/item-191?addview 

 

Map Ini’s (Rob38) 

A good tutorial that covers the basics and limitations of map.ini files. 

http://www.the3rdage.net/item-215?addview 

 

Snow in BFME1 Map (GothmogtheOrc) 

A map.ini that allows snow for BFME 1 maps. 

http://www.the3rdage.net/item-448?addview 

 

Camera System (robnkarla) 

An excellent tutorial on the BFME 1 camera system, and customising the system using code. 

http://www.the3rdage.net/item-404?addview 

 

Skybox/CINE objects (Rob38) 

A tutorial that helps explain skyboxes and cinematic objects 

http://www.the3rdage.net/item-164?addview 

 

Film Map Image (New Line Cinema) 

A good Middle Earth map image (1400x1414 pixels) 

http://www.strefarpg.pl/gfx/tworcy/middle-earth.jpg 


